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Single family house -exercise

4.3.2019



Archicad – Intelligent materials

4.3.2019



4.3.2019

You can click on the welcome screen and proceed 

Use “AC20_talo200.tpl” template to open a new archicad project

The file is available form “Other files needed for CW2”

https://drive.google.com/open?id=1Z4pZND680OCIdLHy1HbIem5_8s3pdVSy

https://drive.google.com/open?id=1Z4pZND680OCIdLHy1HbIem5_8s3pdVSy


AC20_Talo2000.tpl 

4.3.2019

RT 3D tyyppirakenteet ArchiCAD ohjelmaan

https://www.rakennustieto.fi/index/tuotteet/kirjastot/kirjasto/203/Kirjasto_tuotteet/6073.html

Archicad template: http://mad.fi/tiedostot/ac20/AC20_Talo2000.tpl

(or linked from earlier page)

http://mad.fi/tiedostot/ac20/AC20_Talo2000.tpl


Missing library

4.3.2019

Delete ”kirjasto 20” and we will add

”kirjasto 21” (download it from

mycourses or link provided and unzip

it in a folder)

The template we used earlier have

layers for Finnish classification

system as well as other elements

required for the wall types to be used

in this exercise. So Finnish library is 

linked for the project. 

The Finnish ”kirjasto 21” is available

from mycourses.

Skip ”missing libray parts” info after

loading library 21

click ”Add > add linked library…..”

Browse to the extracted folder

and choose to activate/add to the

library.

Click ok



4.3.2019

Composites - imported

Composites imported from ”composite elements.aat”



Import composites

4.3.2019

1

2

3

Select all the composite materials

and append them to the project

Click ”ok”, If archicad informs

about new material/layer/line

creation -- accept them



Make the ”navigator map ” visible if it is not visible by default

4.3.2019

1. Left click popup navigator form the top right

2. Click ”show hide navigator”

3. Click ”show navigator” 



4.3.2019

Story settings - Kerrosasetukset - Ctrl+7
Right click

Note: the measurement unit in 

Talo2000 template is ”meters” 

not mm.

Save the project as: CW2_yourname.pln



4.3.2019

Project info and settings

Project info: File > Info > project info

Insert project related information here

Eg- Project name: CW2_Aalto_name initials

Project settings: Options >project

preferences

To change project related settings

Eg. Working units/dimensions



Attribute manager

Options > element attributes > attribute manager

Go to composites and open and open “composite elements.aat” 

(available from mycourses)

4.3.2019

Select all the composite elements 

and “append”. Check mark “all 

associated attributes”



Importing dwg floor plan of the
house



Importing dwg file as independent worksheet

Right click > worksheet > new independent worksheet

4.3.2019

File > external

content > attach

Xref

1

2

3

4



Activate 1. kerros (From the tabs or double click from project map )

• Right click on the ”worksheet created – WS-01 and click show as trace reference

4.3.2019

If the reference drawing is not visible

Turn on Xref layers from (ctrl+L) or

option > element attributes > layer

settings

Color properties of reference Elements like ”dimensions/text….” can be

changed and made visible from trace reference palette

Window > Palettes > Trace & reference



Modeling the project



Walls

Outer wall – US 01

4.3.2019

Double click ”wall tool” to go to its settings and 

make following modifications

Left click ”black arrow” on info box longer time to change

geometry method and click to select

More attributes can be attached with the elements from ”tag and catagories > manage IFC properties



4.3.2019

Draw a rectangular wall from one exterior to opposite corner

1

2



Inner walls

4.3.2019
20



Inner walls - VS

VS1

4.3.2019

You can draw all the ”inner walls” with

same composite structure.

Once the walls are finished – change to 

appropiate composite type by selcting

and changing it from info-box



3D VIEW WALLS

Make appropiate

changes as needed

with the wall types

based on the spaces.

4.3.2019



Sauna inner panel wall

4.3.2019



Wooden columns

4.3.2019



Place the columns in their

correct place

4.3.2019



Openings – Door
and windows



4.3.2019



4.3.2019

External doors – UO 1



Placing openings

First click to define insertion point of the opening

Second click to define its opening side 

(orientation)

4.3.2019



4.3.2019

UO 2 – (north wall)



4.3.2019

Other settings as in previous

door

UO 2 – (south wall)



Internal doors



Sisäovi  - Door I Laakapariovi tasajako

4.3.2019



Internal doors

4.3.2019



Door (and window) in sauna panel wall

Use empty door (and window) for sauna 

panel wall to create empty opening

• Settings for the opening same as the

door (or window) placed in the adjacent

sauna wall.

4.3.2019



Windows

4.3.2019



Window types

Ikkuna tyyppi (001,002,004) – Ikkuna 20

Ikkuna 003 – ikkuna kaksiosainen 20

4.3.2019



Ikkuna 001

4.3.2019



Ikkuna 003 – ikkuna kaksiosainen 20

4.3.2019



Slabs: AP, YP.                    Roof: Katto, tiili

4.3.2019



Slab: AP

4.3.2019



Slab: YP

4.3.2019



Katto

4.3.2019



4.3.2019

Make a rectangular

roof from point 1 to 

2 (red)

After placing the

roof, click on the

roof edge and 

modify the shape by

adding points and 

offseting the edges

Follow the dwg floor plan outlines for the position and shape of roof



Chimney - Hormi

Select rectangular geometry method and ”brick wall” 

from basic wall types.

• Make the following modifications shown and draw a 

rectangular wall with reference to the dwg floor plan

4.3.2019



Combining outer walls, roof and columns

Select outer walls, columns and roof

• > right click and select connect > trim

elements to roof/shell

- Trim.

4.3.2019



Slab, Roof subtraction from ”chimney”

Select slab element from the model and select

”slab tool

• Draw the area to subract

• (alternatively subtract from poygon can be

selected in ”pet palette” when clicked on slab

boundry or corner; and drawing the area to be

subracted)

4.3.2019

• AP
– Select AP (1.kerros) –> select ”slab” tool—> Draw the area to subtract

• YP
– Select YP (2.Katto) –> select ”slab” tool—> Draw the area to subtract

• Katto
– Select Roof (2.Katto) –> select ”roof” tool—> Draw the area to subtract



3D section

3D sectional views can be derived in may ways

• Activate 3D Cutaway (ctrl + y) and select and drag the

”scissors” to define section plane

• Define an area in floor plan using ”Marquee tool” -> 

right click -> show selection/marquee in 3D

4.3.2019



Foundation
Profiled wall tool



Foundation

Profile manager : 

Options > Element attributes > profile manager

Or

Window > palettes > profile manager

Click edit profile and Create a T 
profile as shown using ”Fill” tool

Select appropiate building
material fill. This defines the
main material to be used for 
foundations

Notice the origin for the profile. This
origin defines the reference point of the

element when drawn.

Click store profile
once the shape and 
position is finished. 

Provide a name: 
Perustus



• Go to 0. Perustus in the project map

• Make 1.Kerros visible through trace and 

reference

• Draw Profiled wall (– see right side picture) 

alongside the exterior side of ”core” of the

outer walls.

4.3.2019

A different slab element (5mm thick) is put on the top of AP in sauna and dressing room.



Terrace slabs
Make rectanglular slabs with the

settings shown in the left picture

4.3.2019

Copy ”bottom (southern) 

slab” and paste at the

same place

Select the copied slab

and extend (offset) one

side to 300mm.

Move the slab 150 mm 

below the top slab to 

create steps



Creating ground – Mesh tool

4.3.2019

Go to 0. Perustus floor

Select ”mesh tool” and change the settings

Make appropiate
site geometry –

rectangular
or polygonal



Select the ”mesh” created and select ”mesh

tool”

• Draw along the foundation wall and the steps

of terrace marked with blue in the right picture

• Once finished – add new points

4.3.2019

Elevate the mesh points (all in 

north direction) to 150 mm.

Click on the point and select

”elevate mesh point”



Modeling part of 
the project ends

here
Next we will document the project



Material creation in 
archicad - Extra



Options > Element attributes > (1,2,3) 

1. Surface (Pintamateriaali)

- Lautaverhous

2. Building material (Rakennusaine)

- Lautaverhous

3. Composites (Rakennetyyppi)

- US-01

4.3.2019

Archicad material - exercise

1

2

3



1. Surface

Options > element attributes > surface

4.3.2019

Select ”new from

catalog” and select

”Vuoraus- sininen20”

Kirjasto20 > seinäpinnat GS 20 > Vuoraus GS 20 > vuoraus sininen 20 



2. Building materials

Options > element attributes > building materials

4.3.2019

Select ”wood surface” 

from the list of building

material and make its

duplicate so that all the

properties realted to 

wood is copied

1

2

3

4

5



3. Composite – US 01

Options > element attributes > Composite

4.3.2019

• All the buidling material are

not available in the ”selected

template”

• We will bring these finished

components from other file.

• ”composite elements.aat”



Documentation
- Arhcicad
Using IFC file saved from the
modeling part.



Open Archicad and IFC file with archicad

Library parts location – embedd within the project

IFC import result is shown only if MEP add on is added

to archicad

Click ok to proceed.

4.3.2019



Make ”navigator” visible

4.3.2019



Layer combination

Make a new layer combination ”00 Exercise”

Select all layers on the right

Make all layers visible

Unlock all layers

(Find ”IFC Openings” layer and turn it off)

Remember to update the layer combination

definition

4.3.2019



4.3.2019

Select the roof. Right click and Select ”object selection

settings” and make following changes shown below

Select the roof. Right click and now

select ”display order” then ”send to back”



Display settings

Apply graphic override to ”simplified plan”

Select ”zone tool” and select all the zones in 

the model (edit -> select all zones or ctrl+A)

• Make the following changes

4.3.2019



Section and elevations

Sections:

• Select ”section tool” from document

tool group

• Put two section markers S01 and S02

Elevation

• Select ”elevation tool” from document

tool group

• Put elevation markers E01; E02; E03; 

E04 

- E01 –South elevation

- E02 – West Elevation

- E03 – East Elevation

- E04 – North Elevation

4.3.2019

Click and define two points for starting and end position of markers, then click to specify direction



View map - Views

Go to Project chooser

• Hide navigator

• Show organizer

- Drag (by the top of organizer window) and 
place the organizer in the place of navigator)

Go to view map. Right click on the top of project

(projekti) and create a new folder ”drawings”

4.3.2019



Select project map (in left panel of organizer) and drawings

folder on the view map ( in right panel of organizer)

• select 0. 1. Kerros on the left and click save view to place it 

inside the folder

• Repeat the procedure for ”sections” and ”elevation” groups

• (Note: update the scale of 1 kerros to 1:50 )

- Right click on the view and go to view settings

4.3.2019

Check and match the

view settings and storing

options from project map

below when you select

individual views

• 0.1.Kerros

• S01 

• S02

• E01, E02, E03, E04



Go to 3d – Generic perspective view and make a suitable orientation

• Orbit – shift + mouse wheel

• Zoom in/out – mouse wheel

Once the you get a suitable view — Save view ”SE View”

4.3.2019

Graphic override selected as 01 –existing plan for 3d window



More views

• 3d section view

- Select Marquee tool

- Make a rectangular selection (thick

dotted lines are for all the stories)

- Right click and select ”show 

selection/marquee as 3d or press F5

4.3.2019

• 3D projection and shadow settings

- Right click > 3d window settings

• (for display settings of 3d window) : 

turn sun shadows on

- Right click > 3d Projection settings

• (for projected views like perspective or

axonometric) : change the sun position 

by click and drag to define sun position



Once the desired view is set:

- Save view – ”3D section”

3D section top view

• Right click > show all

• Right click > 3d projection setting

- Scroll to zoom out

- Activate 3D cutaway

• View > elements in 3D view > 3d cutaway (or Ctrl+Y or icon from the toolbar)

4.3.2019

Once active – a scissor icon will appear in the 3d window in all (4) directions

Drag by the scissor (top) and place it somewhere at the height of window lintel level so that the

plane just cuts the window



Click finalize to place the cutting plane

Go to 3D projection setting (right click on empty place in 3d window)

- Click ”parallel projection” and select ”top view”

4.3.2019

Save current view ”3D Top View”



Resulting top 3D view

4.3.2019



Go to ”SE view” 

- Save two views> name it as ”SE white model” and ”SE rendered view”

4.3.2019

All views until now
Schedules – QTO 

(quantity take-offs)



4.3.2019

Make ”schedule” folder in view map

Save the views from Project map as shown in the picture

Modifying schedules

• Wall schedule

- Double click to open the schedule

- Modify the fields in ”Full element ID section” (remove extra numbers from end)

Click ”show headline” to 

merge similar items



Schedule scheme settings

Use to add or remove criteria and element fileds of the elements

Wall schedule fields:

4.3.2019

Drag by the

arrows to 

reposition the

field order



Opening schedule fields

4.3.2019

Other settings

(cell height to fit the

content)



Layout

4.3.2019



Master layout VS views

Master layout – base layout for making the layouts

• Master layout – reptiting informations – like name plate

• Layout – place views

Master layouts

4.3.2019

• Create three master layouts

• Define their respective size

• Set margin of 5 mm



A4  master settings

4.3.2019



Put the nimiö20.gsm in the layouts

Object tool > load other object > browse for the file (downloaded from mycourses)

4.3.2019



Revision history detailed 20 – object

Place in the master layout and modify

its settings

4.3.2019

If size needs to be changes (drag 

by points after placed)

Copy ”nimiö” and ”revision history” objects to other layouts (right bottom corner)



Create layouts – 6 nos

Modify its name and master templates they use (shown below)

4.3.2019

A4

A2

A3



Placing views in 
Layout  



Organizer view

Select ”sheet index” layout on right and ”sheet

index” view on left > click ”place drawing”

- ”Sheet index” layout has now ”sheet index
drawing”

• Open ”Sheet index” layout (double click)

- Modify the location and size of the ”sheet index
drawing”

• Modifying (click on the black hotspot) and select
appropiate modification tool (move) from pet palette

• Place the drawing in the top center of page

4.3.2019



Drawing title

Select the ”sheet index drawing” if

not selected

- Go to the drawing settings and 
turn off ”Drawing title”

4.3.2019

Place other views to relevant layouts

Select multiple

views on the ”view

map and ”layout” 

on layout map to 

place multiple

views at once



Organize the views

• Double click on the layout 

- Select ”0.1.kerros” drawing from the
paper

- Go to the settings > change the drawing
scale to 1:50

- Place it in the paper at correct position

4.3.2019

Other properties like visibility of elements in text size and color can be modified from”drawing title”



Elevation and section layout

4.3.2019

• Two sections in the layout are

positioned in the right.

• Normally drawings should

contain annotatoins to provide

information

• Document tools of archicad can

be used for that purpose, 

however we will make visibility

of floor height information in the

sections

• Open  ”S01”  view in the view

map and go to ” section

settings” (right click in the empty

space)



On the ”story levels” 

• Change ”show story levels” > display and output” 

Repeat the process for S02

Check the layout, the views should be automatically

updated

• If not > select the drawing (S01) in the layout and 

click on the edge (right)

• Select offset edge and extend on the right

- Repeat for the left edge

- And repeat for S02

4.3.2019



3D views

Select all the drawings of 3D views and go to the drawing settings (info box or ctrl +T)

4.3.2019

Change the magnification to 50% and rearrange

the views on the top of layout

Drawing alignments can be accessed from ”Edit > 

Align >….. ( you need to select the drawings)

Drawing scale information is not required for the views

Find the ”show drawing scale” from title of the settings dialogue box and 

turn it off



Repeat the process for another 3d layout

4.3.2019

You have to make an 

individual 3d view of your

choice for this place



3D rendered view and white model rendering

Open ”3D rendered view” from view map and 

open photorendering settings

4.3.2019

Click on the size and assign it to size to 

3D window

Settings

Click the preview

window to see the

output



Go to settings in photorendering window

4.3.2019

Select ”outdoor

daylight medium” 

scene

Check

preview

Right click ”SE 

rendered view” and 

Select ”redefine with

current window settings

Right click and select ”view

settings”

Select ”generate in  -

photorendering window” 

and click ok

1

2

3



1 . Select ””white model effect” in photorendering settings

2. Right click ”SE white model view” and ”redefine with

current window settings”

3. Update ”genarate in Photorendering window” from view

settings

- Remember to press Ctrl + S to save the project

4.3.2019

Repeat the process for ”SE white model” view (Tick mark ”use white model effect” for it) 4

Check the result in 04 3D views layout 

(might take a little bit time for rendering)

Once the rendering is done – go to the individual view’s drawing settings (in layout) for both and 

change the update type to ”manual” (so that it does not render everytime you open the layout.



Update project info (your name and details)

Check the layout of schedule and organize the schedule tables (drawings)

Remember to update cell size if it does not fit in the A3 paper

File > info > project info

Contact full name : your name

contact role: student id

Also put an imaginary ”site details for rakennuskohde”

4.3.2019



Publishing PDF 
files of the project



Go to the publisher set (on the right) and Layout book

(on the left)

• Create new publisher sets ”PFD” and ”IFC”

• Select PDF publisher set and then click on 

publishing properties (To define where to publish)

4.3.2019

Define pubishing method ”save files”

• Create a single file

• Define path

• Click ok

Define file name as 

”Project_yourname_

PDF”



PDF publishing

• Double click ”PDF” sets to open

• Select ”project” from ”Layout book” and place a 

shortcut

• Select the project in publisher set and click

”Publish” - entire set

4.3.2019

Click close

once done



”IFC” Publishing

• Set the settings to either

”create a real folder structure” 

or ”create a flat file strcuture”

4.3.2019

”IFC” Publishing

• Place a 3d view ”SE View” from view map to ”IFC” 

publisher set

• Select the placed view and change the file type to 

”IFC file”

• Publish entire set

Rename file as 

”Project_yourname_IF

C” from the published

folder once published



BIMx

”BIMx” publisher sets

• From view map

- Place ”SE view” 

• From layout book

- 01 Elevation and sections

- 02 floor plan” from layouts

Click publish (entire set) to publish ”BIMx” 

File

4.3.2019

Create ”BIMx” publisher set

Publishing method for BIMx

Define file name as 

”Project_yourname_

BIMx”

BIMx hypermodel - https://www.youtube.com/watch?v=ze3y6dqqsXs

https://www.youtube.com/watch?v=ze3y6dqqsXs


Submit the publishedfilesthroughmycourses

”Pdf ” 
”BIMx” 
”IFC” 

Thank you


